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Sending Timecode from Reaper to Titan on
another PC

This is an example of how to use Reaper - a much more powerful DAW (digital audio workstation) than
Winamp - to send timecode to Titan, assuming both are installed on two separate PCs. MIDI is being
sent over network using rtpMIDI.

Prerequisites

1. of course both computers need to be networked and configured properly (same network mask,
correct IP addresses etc.)

2. Titan PC-Suite, from v12 on (External AvoKey or T2 required - T1 or Editor Avokey does not
work)

3. rtpMIDI (see Software List, to route the MIDI signal from one computer to the other

Reaper (see Software List)

5. you may consider using the vWIMTC plugin for Reaper in order to have timecode also when
stopped or paused

P

Make it run

1. rtpMIDI

This needs to installed on both machines. rtpMIDI provides a virtual MIDI port which is then bein
forwarded over the network to other participants of this session. There is a compact tutorial provided
at the rtpMIDI website. Usually setting this up is as easy as checking the session is enabled in both
machines, and both see each other.

The two pictures show the setup which was used in the a.m. youtube video - SB-HP is the laptop
running Titan while rtpl is the session on the laptop running Reaper.
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| found that Titan is allergic to MIDI ports being added or removed while Titan is running.
The safest route is, after installing and configuring rtpMIDI, to completely restart the
computer which runs Titan.

2. Titan PC Suite

In order to initially watch the timecode open a timecode workspace window (e.g. Timecode 1) and
select MIDI as timecode source.

Timecode 1 [ = .Jl'.#jl'.f‘}]jl:}(]

00:00:00.00

Disabled

3. Reaper

Launch Reaper. Load a track if you want (not required for this to function). However here are the
steps to configure Reaper correctly:
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3.1 Enable MIDI Output

In the Options menu select Preferences - this opens the preferences window. Find MIDI devices in
the Audio section. This should list the virtual MIDI port you created in rtpMIDI as MIDI output:

—
|

G REAPER Preferences

MIDI Devices a | MIDI hardware settings

Buffering MIDI inputs to make available (selectable as track inputs and/or leamable or action-bindable):

Mute/Solo Device - Mode ID
Playback

Seeking g Enabled+Control 0

Recording

Loop Recording

Rendering
Appearance

Media

Peaks\Waveforms

Fadez/Crossfades ) i Add joystick MIDI...
Track Cortral Pansls MIDI outputs to make au.?‘l\!able (selectable as track outputs):

Editing Behavior Device Mode D

Envelope Display Microsoft GS Wavetable Synth Juse cautiously]  <disabled: 1]

Automation tp Enabled 1
Mouse

et

Mouse Modifiers

MIDI Editor
Media

MIDI

Video Import/Misc Restrict MIDI hardware output to one thread Reset all MIDI devices

Plug-ns
Compatibility v | Pesetby: [v]Alnotes-off Pitch/sustain Reseton: []Play [ ]Stop/stopped seek

[ ] Find Cancel | IR

Right-click on the port in the output section and either tick Enable output from the menu...
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ﬁ REAPER Preferences B X
MID| Devices » | MIDI hardware settings
Buffering MID| inputs to make available (selectable as track inputs and./or leamable or action-bindable):
Mute/Solo Device Mode 0
Playback
Seeking tp Enabled+Contral 0
Recording
Loop Recording
Rendering

Appearance
Media
Peaks/Waveforms
Fades/Crossfades MIDI oLtputs to make avalable (selectable as track outputs): Sl DLl
Track Cortrol Panels outputs to ma eavia = able as track outputs):

Editing Behavior Device Mode D
Envelnpra Display Microsoft GS Wavetable Synth [use cautiously]  <disabled: 0
Automation fp Enabled 1
Mouse ]

Mouss Madifiers Configure output...
MIDI| Editor
*

Media Cutput 1D
MIDI Forget device
Video/Import/Misc .

Plug-ins . Enable output Reset all MIDI devices
Compatibility v Send clock to output Play []Stop/stopped seek

D t send SPP t tput .
Low latencv outout mode (low orecision]

... or select Configure output.. and make the settings there:

TS
]

635—3533'-5-5-5‘-:-55 ! X
MID| Devices A | MIDI hardware settings
- B — ! A—-———4ahle as track inputs and/or leamable or action-bindable):
m ﬁ Configure MIDI Output .
3 Mode D
5; Device name: |rtp1 | Enabled+Control 1]
Re  plias name: |m |
Loy

R Enable output to this device

fppl []Send clock to this device  [_| Mo SPP/continue

Mg []Open device in low latency/dow precision mode
Pg

Offset output to this device by: -”I:I:::- o —
k ctable as track outputs): Add joystick MIDI...

Tn
3 Cancel Mode o

Ermﬁf Microsoft G5 Wavetable Synth [use cautiously]  <disabled: 0
Automation tp Enabled 1
Mouse
Mouse Modifiers
MID| Editor
Media
MIDI
Pl"n.ﬁdv:en,-"lmpurtf"l"-"lisc Restrict MIDI hardware output to one thread Reset all MID| devices
Lg-ins
Compatibility w | Pesstby: [ Alnotesoff Pitch./sustain Resst on: [~ Play [ ]Stop/stopped seek
Enable the MIDI Output devices you wish to use by right-clicking an the Device A
I:I Find name and selecting Enable Output. OK Cancel Apply
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Confirm the settings with OK to close the preferences window.

3.2 Insert Timecode Generator

Rewind the timeline to 0:00:00 (simply press <Pos 1>). From the Insert menu select SMPTE LTC/MTC
Timecode Generator. This inserts this generator as new track.

zct] - REAPER vB.08/%64 - Registered to Temporary License (Commercial license, &
Insert  Item Track Options Actions  Help [Insert timecode generator
Media file... EIMFG
Mew MIDI itern
Empty item

SMPTE LTC/MTC Timecode Generator

I Click source

Mew subproject

Marker M
Marker (prompt for name) Shift+M
Region (from time selection) Shift+R
Tempo/time signature change marker Shift+C
Measure from time selection (detect tempa) Alt+Shift+C

Measure from time selection (new time signature)...

Track Ctrl+T
Multiple tracks...
Virtual instrument on new track...

Track from template >

Empty space at time selection

If you had already inserted an audio track then probably the timecode track was inserted on the same
track. Simply click, drag and drop it onto a new track:
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03_trust-il o FX

Also, it's a good idea to bring the timecode track (at least) to the same length like the music:

3.3 Adjust Timecode Generator

Right-click on the new timecode track, and from the context menu select Item properties:
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[tem settings
[termn properties..,

Source properties...

Group
Take

Comps

[tern and take colors
[termn processing

Stretch markers

(or, with the timecode track selected hit F2).

This opens the Media Item Properties window:

F2
Ctrl+F2
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Media ltem Properties: Timecode Generator ,¥

]
||
||
[ |
| |

If you want then you can change length, position and other details. In any case you need to make
sure it is MTC (MIDI timecode): click on the Properties button (at the bottom). In the new little
window set the properties to Send MIDI (MTC):
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Media ltem Properties: Tirmecode Generator ¥

0:00.000

Track/project default timebase e

Project default tem mix behavior w

6 SMPTE Generator Properties

() Send audio (LTC)  (®) Send MIDI (MTC)
Frmrit&:|3ﬂ_|]] v|

Start time: [0.00:00:00 | thh:mm:ss ff)

User value 1 (0-255):
User value 2 (0-255):
User value 3 (0-255):
User value 4 (0-255):

Confirm/close both windows by clicking OK.
3.4 Route the MTC signal

This button slightly depends from your reaper version:

In Reaper v5, click on the routing button in the track controls (left to the timecode track):

or=E i

Sends, Receives, and Hard

© B ED >

In Reaper v6, right-click on the volume knob ov the timecode track.

This opens the routing window for this track. Under MIDI Hardware Output (top-right) select your
virtual MIDI port:
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Routing for track 2 "" n
Master send Parert channels: 1-2 - MIDI Hardware QOutput -
itp1
[ooo)EE= Track channels: 2 \p—ﬁ /|
ED [D Send to original channels w
Pan: |certer | Width: | 1007 | () - Receives -
[] Playback time offset: | | | +0 " Ims | ) samples | Add new receive... w
- Sends -
Add new send. .. w
- Audio Hardware Outputs -
Add new hardware output... w

Close the routing window.

4. Try it out

Essentially this should work straight away: as soon as you hit Play in Reaper, the timecode value in
Titan starts to run. It is advisable to change the time units in Reaper: right-click on the timeline or the
displayed time, and from the context menu select Hours:Minutes:Seconds: Frames.

This also works together with Reaper being controlled by Titan via MMC, like described in Controlling
Reaper from Titan on the same PC
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Internal

Disabled

| Groups

1 2
All Dimmer [ Dimmers]

You can now use this as timecode source to sync cuelists to music coming from Reaper.

| noticed a gap between the timestamps in Reaper and in Titan. This seems to be due to both, Reaper,
as well as Titan/USB Expert, and needs to be investigated further.

Also, Reaper doesn't generate timecode when being stopped or paused. There is a little plugin
available called vVIMTC which circumvents this:

e download the plugin from https://forum.cockos.com/showthread.php?t=43606 or from here
vvimtc_generator.txt

e on your Reaper computer, copy this file to %appdata%\REAPER\Effects

¢ in Reaper, disable (Mute) the previously added timecode track

e add a new empty track

e on tjhis track, add the effect JS vVIMTC Generator, add its properties (framerate etc.)

e route this track's MIDI output to your virtual port as decribed above

e record/arm this track

Now, the timecode sent is accurate also when reaper is stopped or paused.

5. How to debug

If things do not work as expected then there are some tools which help finding the fault:

5.1 loopMIDI

You may route the signal via loopMIDI as explained in Sending Timecode from Reaper to Titan on the
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same PC. Please install loopMIDI and apply the correct settings in Reaper.

Also, in this case rtpMIDI needs to be told to take its input from loopMIDI:

(&) rtpMIDI: Gber Apple Bonjour >

Konfiguration  Erweitert UOber

Meine Sessions Session
T ] Aktviert 5004
ripl
ripl
+| |- Teilnehmer: | Mame Latenz
SB-HP 1 ms
Verzeichnis

Trennen
Adresse: DESKTOP-5VQ114V: 5004
2.0.0,1:5004
192,168,178, 59: 5004
+| - Verbinden
Dieze Benutzer dorfen sich mit mir verbinden | popMIDI Port w | —2 &
Alle ' | e | —

loopMIDI shows the number of transmitted data. This number increases with every command, note or
message. With timecode, this number increases continuously and rather fast.

- o)

(#) loophIDI =
Konfiguration | Erweitert | Uber

Meine Loopback MIDIParts

Mame Durchsatz [ Sek.

0 Byte

 loopMIDI Port

E]E] Meuer Port-Mame: |loopMIDI Port 1

5.2 USB Expert Console
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Open the USB Expert Console.
Select the MIDI tab top-right,
Raw MIDI. Now, as you send a

data like this:
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This must show your virtual MIDI port as connected panel (top-left).
click Watch MIDI, in the MIDI watcher window select MIDI Input and
command, it is shown in the MIDI watcher, with continuously incoming
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Additionally, on the Timecode tab (top-right), you should see the real timecode values running:

L) UsH Bapert Console 8.7.71.5
File  Tecle  Bemcte  Help
 Aoset 3 Sunpand

Coxwsciend Parsls

=L ECES

A TzoMx1

@ T2 sMPTE

S Medadgas
Fawr

Clear

@ ACW USH werace connected...

5.3 MIDI-OX

ben Everds b Savce TedBence MDI [ Tmmcods
Fer Shaw ¢ Hide
E Leds [ v SE-HP
[ Fadens [ Tose Siaems r Tmecade
= w = . . .
B B 00:00:09:26
] Mores: Facler 0 Teradie
00:00:00:00
Tirsscods Conbel
St B
O Terwsoade Traggens
K Delete b Go
Lagnred Gt T Siop Terw
Do Togper Liw  Add Trigges

Another great tool for fault finding (but also for fault generating) is MIDI-OX. One of the things you
should be aware of is that it may take the MIDI signal and doesn't forward it unless told to do so - you
may see proper MIDI messages and wonder why nothing is passed on, and as soon as you close MIDI-
OX, suddenly everything works flawlessly. You have been warned... (Thus, usually use this together
with loopMIDI in order to tap into the signal)
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Install and launch MIDI-OX (see Software List. From the Options menu select MIDI Devices. Make
sure loopMIDI Port is listed as MIDI Input but isn't mapped to any output (yes, you can create a
feedback loop, and yes, you do not want to do this...)

r

i MIDI-OX - [Monitor - Input]

ﬁ File View Actions Options Window Help
FD: BEOEC ¥ Zomo@im Y@ @ @ X

=

[=]

24

&% MIDI Devices

Presets:

TIMESTAMF IN PORT STATUS DATA]1 DATAZ CHAN NOTE EVENT

- @Y =

|

Cancel

Part bMapping:

MID| Outputs: Part Map Objects:
1] Microzoft G5 Wavetable Synth & Channels
2] loopMIDI Port A System
3] MIDI Mapper @ loopMID! Por

& MIDI-O5 Events
du)  MOSYSMAPT xm

| Autornatically attach [nputs to Outputs during 2election.

From the View menu select Input Monitor... In this window, all incoming MIDI data are shown. You
will see the cpntinuous stream of MTC Quarter Freame messages:
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